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Our brand refresh enables us to reinvigorate 
the way we communicate.

The objectives of the DCMS brand refresh are to
ensure visual consistency across printed and digital
media to enable a better understanding of the
Department’s objectives and responsibilities, and
raise its profile amongst its diverse audiences
which include internal stakeholders, the general
public and sponsored bodies.

Brand enquiries 
Promotions and Publicity Unit
contact 0207 211 6051, 0207 211 6048,
0207 211 6356 or 0207 211 6509

Website enquiries
David Armstrong contact 0207 211 6268
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elements



the logo

The logo is a key element of the DCMS brand.

The DCMS logo has been strengthened, with the
additional element of the full name, to enhance awareness
and create better communication.

It is made up of two elements, the box symbol and the
name. To maximise their impact, they have a fixed
relationship that must remain consistent.

The logo must be seen on everything we do, from
publications to stationery to exhibitions. It must always
be applied consistently, in the DCMS colour palette and in
the top left hand corner of an application (unless
otherwise stated).

It should not be redrawn, digitally manipulated or altered.
The logo must always be reproduced from a master
reference. This is available in tiff, eps and jpeg format.

Tiff: all professionally printed applications.
Eps: large format ie exhibitions.
Jpeg: Microsoft programmes.
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10mm

The DCMS logo must always be consistently reproduced
and clearly visible. Therefore a minimum size has been
established for the logo. The size is 10mm measured
across the width of the DCMS box symbol.

There is no maximum size. The logo is available in a larger
file size for large reproduction formats, ie exhibitions.

The DCMS logo is also protected by an exclusion zone.
this will ensure the logo has maximum impact and
visibility on all communications.

The exclusion zone is calculated by using two thirds, of
the height of the box, as illustrated. Please observe this
rule and ensure that no other graphic elements (such as
text or imagery) intrude into the zone.

exclusion zone
two thirds of

the box height

the logo
minimum size
exclusion zone
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colour

PANTONE®
1935 C

PANTONE®
165 C

PANTONE®
3272 C

PANTONE®
308 C

PANTONE®
5125 C

PANTONE®
5483 C

PANTONE®
130 C

PANTONE®
382 C

PANTONE®
279 C

PANTONE®
239 C

To represent the diversity of our work we use a vibrant 
palette of ten colours. The palette should be used for all
communications and in rotation to exploit the full range 
and create maximum impact. No alternative colours 
are permitted.

The colours have been chosen to complement each other 
and can be combined (see page 8 for details).

It is vital the colours are produced accurately across all
communications. Always match the Pantone reference or 
CMYK percentages indicated. The RGB reference is for 
on-screen usage only.

Pantone 5125   C44 M81 Y11 K51   R112 G64 B94

Pantone 308  C100 M19 Y8 K50   R0 G51 B102 

Pantone 3272  C99 M0 Y48 K0   R0 G163 B135 

Pantone 165  C0 M72 Y100 K0   R223 G104 B4 

Pantone 1935  C1 M100 Y51 K6   R241 G50 B53 

Pantone 239  C17 M80 Y0 K0   R210 G27 B122 

Pantone 279  C68 M34 Y0 K0    R10 G131 B223

Pantone 382  C34 M0 Y100 K0   R204 G255 B51  

Pantone 130  C0 M35 Y100 K0    R230 G176 B18

Pantone 5483  C65 M11 Y25 K27   R92 G131 B141

The standards for the PANTONE© Colours are shown in the current edition of the
PANTONE© Color Formula Guide. The PANTONE© MATCHING SYSTEM is a worldwide
printing, publishing and packaging colour language for the selection, marketing and
control of colour. PANTONE© is a registered trademark of Pantone, Inc.
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The logo can appear in any of the DCMS colours on a
white background or reversed white out of the colour
palette. Where colour reproduction is limited it can also
appear in black on a white background or reversed white
out of black.

No alternative colours or combinations are permitted.
See page 6 for colour specifications.
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colour
combinations

The DCMS colour palette has been designed to work
independently or in various complementary
combinations, as shown.

This is particularity effective when resources are limited
and only two colour printing is available, such as for  
level 2 publications.

Suggested colour combinations are shown opposite.
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Pantone 1935 Pantone 239 Pantone 5125 Pantone 239 Pantone 308 Pantone 239 Pantone 5483 Pantone 239

Pantone 1935 Pantone 308

Pantone 1935 Pantone 5125

Pantone 1935 Pantone 130

Pantone 3272 Pantone 130

Pantone 3272 Pantone 239

Pantone 3272 Pantone 165

Pantone 5125 Pantone 279

Pantone 5125 Pantone 382

Pantone 5125 Pantone 130

Pantone 165 Pantone 308

Pantone 165 Pantone 5125

Pantone 165 Pantone 130

Pantone 308 Pantone 279

Pantone 308 Pantone 382

Pantone 308 Pantone 130

Pantone 279 Pantone 382

Pantone 279 Pantone 239

Pantone 279 Pantone 165

Pantone 5483 Pantone 165

Pantone 5483 Pantone 382

Pantone 5483 Pantone 130

Pantone 382 Pantone 130

Pantone 382 Pantone 239

Pantone 382 Pantone 3272

 



typeface
primary
Bliss
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Distinctive and powerful typography reinforces the DCMS
personality and adds impact to our communications.

Bliss is our primary typeface. It was chosen for its
legibility, versatility and availability. The Bliss family
includes a variety of weights, offering extensive design
flexibility. Bliss should be used for all communications,
wherever possible.

Clarendon is our supporting typeface and should be used
with discretion to provide emphasis on the page. Arial is
our substitute typeface, this is only used on our website
and for PowerPoint presentations.

No other typefaces are permitted.

The minimum point size for body copy is 11pt set on
13pt leading.

For detailed typographic specifications please see the
publications section of the guidelines on page 17.

Bliss is available from Jeremy Tankard Typography
www.typography.net

Bliss
Our primary typeface is Bliss. The sans serif was
chosen for the accessibility, simplicity, legibility
and distinctive character of the design. Bliss has
a natural humanist feel and flow. The typeface
family includes many different weights, from
extra light to heavy. Bliss has good visibility
on the page and should be used for all
communications. It offers excellent design
flexibility and character.

BACK TO CONTENTS>



typeface
supporting
Clarendon
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Clarendon is our supporting typeface and should be used
with discretion to provide emphasis on the page. It has
been chosen to compliment Bliss and provide additional
typographic impact.

It should be used minimally to highlight short paragraphs,
the mission statement, headings, quotes etc. Clarendon
should never be used for large areas of body copy.

Copy is generally set in upper and lowercase, ranged left,
ragged right. For detailed typographic specifications
please see the publications section of the guidelines on
page 17.

Clarendon is available from www.linotype.com

Clarendon
Our secondary typeface is Clarendon.
The slab serif typeface was chosen for
its clear, objective, timeless forms and
contemporary feel. In small point sizes
Clarendon is still a legible font and 
in larger print, its individual style
attracts attention and creates impact.

BACK TO CONTENTS>
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The DCMS strapline is a summary of our mission statement.
It is designed to raise our profile and improve
communication with our diverse audiences.

The strapline box device provides a visual connection with
our logo and enables it to be legible on any background.

It appears on the front cover of every publication and in a
prominent position on all other materials. The strapline device
is designed to interact with the individual design of each
application and create a visual balance with the logo. A set of
recommended positions are shown on the following page.
The strapline appears in a set position on level 2
publications. Please see page 37 for detailed specifications.

There are two versions of the strapline:
Strapline box defined with a keyline
This is only used on a white background. The white strapline
and white text version of this can also be used on any
background, provided there is good legibility and reproduction.

Solid strapline box, no keyline
This is used on white, solid colour and image backgrounds.

It can appear in any of the colour combinations shown, (and
white). The strapline must be reproduced from a master file
and is available in eps or jpeg format.

In exceptional circumstances, where space is restricted,
the strapline can appear without the box. It must always 
be typeset in lowercase Bliss Regular. The design must be
approved by the Promotions and Publicity Unit.
Contact numbers: 0207 211 6051, 0207 211 6048,
0207 211 6356 or 0207 211 6509

BACK TO CONTENTS>

strapline box defined by keyline – white backgrounds only

solid strapline box – white, solid colour and image backgrounds only

 



strapline
positioning
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The recommended position for the strapline on level 2
publications is the bottom right hand corner of the page.
This creates a visual balance with the logo.

On level 1 publications greater design flexibility is
permitted and the position can be determined by the
other elements on the page.

The strapline can move vertically along the right hand
edge of the design area.

The strapline box should never be positioned in close
proximity or visually overpower the DCMS logo.

improving 
the quality 

of life for all

improving 
the quality 

of life for all

improving 
the quality 

of life for all

improving 
the quality 

of life for all
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mission statement

Our aim is to improve the quality of life for all
through cultural and sporting activities, support
the pursuit of excellence, and champion the
tourism, creative and leisure industries.

Department for Culture, Media and Sport 13

Our mission statement sets out our aims and objectives.

The statement appears prominently on the inside front
cover (or first page) of every publication we produce and
wherever possible on all other materials.

Level 1 publications and all other materials can customise
the style of the mission statement to complement the
individual design. The mission statement always appears
in Bliss or Clarendon.

On all level 2 publications the mission statement is
typeset in a consistent size and position. Please see 
page 39 for detailed specifications.

On self-cover documents and DL leaflet, where space is
restricted, the mission statement can appear on the back
cover. It should appear at the top of the page ranged left
or at the base of the page ranged right. Please see page
26 for specifications.

OUR AIM IS TO IMPROVE
THE QUALITY OF LIFE FOR
ALL THROUGH CULTURAL
AND SPORTING ACTIVITIES,
SUPPORT THE PURSUIT 
OF EXCELLENCE, AND
CHAMPION THE TOURISM,
CREATIVE AND LEISURE
INDUSTRIES.

Our aim is to improve the quality of life for all 
through cultural and sporting activities, support 
the pursuit of excellence and champion the 
tourism, creative and leisure industries

Our aim is to improve the quality of life for all
through cultural and sporting activities, support the
pursuit of excellence, and champion the tourism,
creative and leisure industries.

Level 1 Level 2

BACK TO CONTENTS>



2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk

contact information
Department for Culture, Media and Sport 14BACK TO CONTENTS>

Dimensions 
297/210mm
all measurements 
in millimetres

Logo
15mm wide

Address 
11/13pt Bliss Light

Web address
11/13pt Bliss Medium

DCMS contact details should appear on the outer back
cover of every publication. The contact details must
always feature the logo, address and website. They appear
in a consistent size and position on every publication.

The logo and contact details can appear in any of the
DCMS colours or white reversed out of a colour
background. The logo must always appear in the same
colour as the address and website

10

53

12

15

contact detail examples

2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk

2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk



co-branding 
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Independent and partnership organisations that are
working with the DCMS require a joint branding. This
works on two different levels of branding hierarchy.

Joint ventures (50:50 relationship)
This is when a partnership organisation is working
alongside the DCMS in a joint initiative. The partnership
logo should have a similar hierarchy and status as the
DCMS logo. The other organisation’s guidelines should
also be consulted.

On front covers the partnership logo can appear in white,
black or its own colour, provided this complements the
design and print specification. It should be placed at the
base of the page, ranged left.

Accreditation (80:20 relationship)
This is when the DCMS is the lead organisation and the
partnership organisation is endorsing the initiative. The
partnership logo can appear in white, black or its own
colour, provided this complements the design and print
specification. It should only appear on the outer back
cover, in a similar size relationship to the DCMS logo.

BACK TO CONTENTS>

2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk

improving 
the quality 

of life for all
LOGO LOGO

Level 2 publication heading
Month 2006

Joint venture co-branding Accreditation co-branding (back cover)

 



DCMS accreditation
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The DCMS is often involved at an accreditation, consultant
or supporting level on other organisation’s initiatives. The
DCMS logo should always appear in order to highlight our
role in these initiatives and to raise our profile and public
awareness.

Other organisation materials (20:80 relationship)
When the DCMS is endorsing another organisation’s
initiative the DCMS logo should have a strong visual
presence on the page. The preferred placement is on the
front cover. The visual relationship between both logos
should be balanced. The alternative preferred position is on
the outer back cover.

The DCMS logo can appear in white, a colour from the
palette or black. The DCMS logo must always be
consistently reproduced and clearly visible. The minimum
size and minimum clearance guidance must be followed.

The minimum size is 10mm measured across the width 
of the DCMS box symbol. The logo exclusion zone is
calculated by using two thirds, of the height of the box,
as illustrated.

10mm

exclusion zone
two thirds of

the box height

PANTONE®
1935 C

PANTONE®
165 C

PANTONE®
3272 C

PANTONE®
308 C

PANTONE®
5125 C

PANTONE®
5483 C

PANTONE®
130 C

PANTONE®
382 C

PANTONE®
279 C

PANTONE®
239 C
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publications

improving 
the quality 

of life for all

ANNUAL REPORT 2006

improving 
the quality 

of life for all

Supporting excellence

Our mission

improving 
the quality 

of life for all
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Publications are one of our most visible communication
tools. They promote the work of the DCMS and provide a
vital link with our audiences. DCMS publications are
divided into two levels. Detailed design specifications for
each level are illustrated on the following pages.

Level 1
Promotional publications
These are commissioned by the Promotions and Publicity
Unit, working in conjunction with a design agency. They
are bespoke publications and are permitted a high level of
design flexibility. Level 1 publications can be produced in
alternative, non-standard sizes if this is appropriate to the
design concept.

Level 2
Standard publications
These are commissioned by the Promotions and Publicity
Unit, working in conjunction with typesetters. Level 2
publications are economical single or two colour
publications, designed to a set grid structure. They are
always produced in standard sizes, either A4 or A5
portrait.

All publications should be printed on recycled or
environmentally friendly, accredited paper stock.

improving 
the quality 

of life for all

Consultation on Media Ownership
Month 2006

improving 
the quality 

of life for all

Draft Gambling Bill
The policy
November 2006

improving 
the quality 

of life for all

Review of the Royal Charter
Month 2006

Level 1

Level 2
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publications
level 1
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Level 1 publications are allowed a degree of creative
freedom, they can use photography, illustration and
typography to create a dynamic, inspirational design.
Key elements of the brand must be consistently applied:

cover
Logo – consistent size and position
Strapline box – consistent size
Title set in Bliss or Clarendon

inside front cover (or initial pages)
Mission statement – customised 

inside back cover
DCMS imprint – consistent size and position

outer back cover
DCMS logo, address and website – consistent size 
and position
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Museums

improving 
the quality 

of life for all

Planning for play

SUPPORTING EXCELLENCE

improving 
the quality 

of life for all

Our mission

improving 
the quality 

of life for all

ANNUAL REPORT 2006

improving 
the quality 

of life for all
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publications
level 1
A4 covers
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Dimensions 
297/210mm
all measurements 
in millimetres

Logo
20mm wide

Heading
Bliss or Clarendon

Sub heading (optional)
Bliss

Strapline box
23mm wide

Level 1 publication covers can use any of the DCMS
colours. They are generally printed in 4 colour.

The logo must always be consistently sized and
positioned on the page, as shown.

The strapline box position is dictated by the cover design.
It is designed to interact with the elements on the page.
The strapline box can be a single or two colour
combination.

Headings must be well written, engaging, informative and
concise. Avoid writing long headings that lack impact.

2018

14

Publication heading

improving 
the quality 

of life for all

 



publications
level 1
A5 covers
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Dimensions 
210/148mm
all measurements 
in millimetres

Logo
17mm wide

Heading
Bliss or Clarendon

Sub heading (optional)
Bliss

Strapline box
19mm wide

Level 1 publication covers can use any of the DCMS
colours. They are generally printed in 4 colour.

The logo must always be consistently sized and
positioned on the page, as shown.

The strapline box position is dictated by the cover design.
It is designed to interact with the elements on the page.
The strapline box can be a single or two colour
combination.

Headings must be well written, engaging, informative and
concise. Avoid writing long headings that lack impact.

1713

11.5
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PUBLICATION HEADING
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publications
level 1
DL covers
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Dimensions 
210/99mm
all measurements 
in millimetres

Logo
15mm wide

Heading
Bliss or Clarendon

Sub heading (optional)
Bliss

Strapline box
17mm wide

Level 1 publication covers can use any of the DCMS
colours. They are generally printed in 4 colour.

The logo must always be consistently sized and
positioned on the page, as shown.

The strapline box position is dictated by the cover design.
It is designed to interact with the elements on the page.
The strapline box can be a single or two colour
combination.

Headings must be well written, engaging, informative and
concise. Avoid writing long headings that lack impact.

1511

10

main heading 

improving 
the quality 
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Publication main heading
Sub heading is typeset in the typeface Bliss
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publications
level 1
A4 landscape
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Level 1 publication covers can use any of the DCMS
colours. They are generally printed in 4 colour.

The logo must always be consistently sized and
positioned on the page, as shown.

The strapline box position is dictated by the cover design.
It is designed to interact with the elements on the page.
The strapline box can be a single or two colour
combination.

Headings must be well written, engaging, informative and
concise. Avoid writing long headings that lack impact.

Dimensions 
210/297mm
all measurements 
in millimetres

Logo
20mm wide

Heading
Bliss or Clarendon

Sub heading (optional)
Bliss

Strapline box
23mm wide

2018

14



publications
level 1
alternative sizes
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Level 1 publications can appear in alternative, non
standard sizes. These should only be considered if it is
relevant to the design concept and content.

The size and position of the logo is established by using
the closest size relationship guidelines (ie A4, A5) and
reducing or enlarging proportionately.

On front covers the logo and strapline box should not
appear smaller than 15mm wide.

MAIN HEADING
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the quality 

of life for all

15mm 15mm
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publications
level 1
mission statement
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Our mission statement appears prominently on the inside
front cover (or first page) of every publication we produce.

Level 1 publications customise the style of the mission
statement to complement the individual design. The
mission statement always appears in Bliss or Clarendon.

Our aim is to improve the quality of life for all
through cultural and sporting activities, support
the pursuit of excellence, and champion the
tourism, creative and leisure industries.

OUR AIM IS TO IMPROVE
THE QUALITY OF LIFE FOR
ALL THROUGH CULTURAL
AND SPORTING ACTIVITIES,
SUPPORT THE PURSUIT 
OF EXCELLENCE, AND
CHAMPION THE TOURISM,
CREATIVE AND LEISURE
INDUSTRIES.

Our aim is to improve the quality of life for all 
through cultural and sporting activities, support 
the pursuit of excellence and champion the 
tourism, creative and leisure industries

Our aim is to improve the

quality of life for all through

cultural and sporting

activities, support the pursuit

of excellence, and champion

the tourism, creative and

leisure industries.

 



publications
level 1
DL/self-cover mission statement
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On self-cover and DL publications, where space is
restricted, the mission statement can appear on the back
cover. It should appear at the top of the page or at the
base of the page, ranged right.

Level 1 publications customise the style of the mission
statement to complement the individual design. The
mission statement always appears in Bliss or Clarendon.

Our aim is to improve the quality of life for all 
through cultural and sporting activities, support the 

pursuit of excellence, and champion the tourism,
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Distinctive and powerful typography reinforces the DCMS
personality and adds impact to our communications.
Level 1 publication text spreads should fully exploit the
DCMS colour palette and use photography or illustration
to add emphasis and highlight key information.

Level 1 publications use Bliss and Clarendon. The Bliss family
includes a variety of weights, offering extensive design
flexibility. Clarendon is our supporting typeface and should
be used with discretion to provide emphasis on the page. It
should be used minimally to highlight short paragraphs, the
mission statement, headings, quotes etc.

Typography should be strong, distinctive and clear. All
text spreads should be well structured and the different
typeface weights used to provide clear navigation on the
page. Headings have no fixed size. The minimum point
size for body copy is 11pt set on 13pt leading.
All body copy must be set in Bliss. No other typefaces are
permitted. Copy is set in upper and lowercase, however
capitals can be used for small areas of copy.

Copy must be well written, engaging, informative and
concise. Avoid writing long headings that lack impact.
Well crafted copy and clear, effective, modern design
allows us to engage with our audiences.

Standard letter and word spacing must always be used. Type
must not be condensed or expanded using computer
software. Hyphenation should be turned off. ‘Widows’ and
‘orphans’ within text should be avoided (wherever possible),
either by tracking or kerning (to a maximum of -3) and
copy-editing.
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Dimensions 
297/210mm
or 210/148mm
all measurements 
in millimetres

Logo
15mm wide

Address 
11/13pt Bliss Light

Web address
11/13pt Bliss Medium

The DCMS outer back cover must always feature the logo,
address and website. They appear in a consistent size and
position on every publication.

The logo and contact details can appear in any of the
DCMS colours or white reversed out of a colour
background. The logo must always appear in the same
colour as the address and website
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Dimensions 
210/99mm
all measurements 
in millimetres

Logo
13mm wide

Address 
11/13pt Bliss Light

Web address
11/13pt Bliss Medium

Insert a 3mm space after the 
web address

Imprint
9/11pt Bliss Roman

On DL publications, where space is restricted, the outer
back cover must always feature the logo, address, website
and imprint. They appear in a consistent size and position
on every publication.

The logo and contact details can appear in any of the
DCMS colours or white reversed out of a colour
background. The logo must always appear in the same
colour as the address and website.

The imprint appears in any of the DCMS colours or black.
It can also appear white reversed out of a colour.
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Level 2 publications are designed to a uniform grid
structure. The covers are printed in one or two colours,
from the DCMS palette. Inside pages print single colour,
black. (In certain circumstances text pages can be two
colour). Level 2 publications are designed to a uniform
grid structure. They are always produced in standard sizes,
ie A4 or A5 portrait. The brand must be consistently applied:

cover
Logo – consistent size and position
Strapline box – consistent size and position
Title – consistent size and position
Boxed area – consistent size and position

inside front cover (or initial pages)
Mission statement – consistent size and position

inside back cover
DCMS imprint – consistent size and position

outer back cover
DCMS logo, address and website – consistent size 
and position
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297/210mm
all measurements 
in millimetres

Logo
20mm wide

Heading
28/30pt Bliss Bold

additional 2mm space between
heading and sub heading

Sub heading (optional)
18/20pt Bliss Light

text column width 175mm

Publication date
14pt linespace before date
12/14pt Bliss Roman

Boxed area
194mm high
194mm wide

Strapline box
23mm wide

Level 2 publication covers are designed to a set grid
structure and can utilise any of the colour combinations
shown on pages 32 to 36. Level 2 publications are printed
in either one or two colours.

All the brand elements, positions and dimensions must be
consistently applied to achieve clear and effective
communications.

Headings and publication dates are set in upper and
lowercase.

Duotone or single colour images that are appropriate to
the publication subject and utilise the DCMS colour
palette can also be placed inside the boxed area. Always
ensure the copy is legible against the background image.
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210/148mm
all measurements 
in millimetres

Logo
20mm wide

Heading
22/24pt Bliss Bold

additional 2mm space between
heading and sub heading

Sub heading (optional)
14/16pt Bliss Light

text column width 175mm

Publication date
13 pt linespace before date
11/13pt Bliss Roman

Boxed area
136mm high
136mm wide

Strapline box
19mm wide

Level 2 publication covers are designed to a set grid
structure and can utilise any of the colour combinations
shown on pages 32 to 36. Level 2 publications are printed
in either one or two colours.

All the brand elements, positions and dimensions must be
consistently applied to achieve clear and effective
communications.

Headings and publication dates are set in upper and
lowercase.

Duotone or single colour images that are appropriate to
the publication subject and utilise the DCMS colour
palette can also be placed inside the boxed area. Always
ensure the copy is legible against the background image.
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Dimensions 
297/210mm
all measurements 
in millimetres

Mission statement
20/24pt Bliss Light

The mission statement must 
be typeset, with the correct
linebreaks, as shown

Our aim is to improve the quality of life for all
through cultural and sporting activities, support the
pursuit of excellence, and champion the tourism,
creative and leisure industries.
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Our mission statement appears prominently on the inside
front cover (or first page) of every publication we produce.

On all level 2 publications the mission statement is
typeset in a consistent size, font and position.

The mission statement appears in any of the DCMS
colours or white reversed out of a colour background. The
DCMS colour combinations can also be used. Always
ensure the copy is legible against the background colour.
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Our aim is to improve the quality of life for all
through cultural and sporting activities, support the
pursuit of excellence, and champion the tourism,
creative and leisure industries.
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Dimensions 
210/148mm
all measurements 
in millimetres

Mission statement
14/17pt Bliss Light

The mission statement must 
be typeset, with the correct
linebreaks, as shown

Our mission statement appears prominently on the inside
front cover (or first page) of every publication we produce.

On all level 2 publications the mission statement is
typeset in a consistent size, font and position.

The mission statement appears in any of the DCMS
colours or white reversed out of a colour background. The
DCMS colour combinations can also be used. Always
ensure the copy is legible against the background colour.
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Our aim is to improve the quality of life for all
through cultural and sporting activities, support the
pursuit of excellence, and champion the tourism,
creative and leisure industries.
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Our aim is to improve the quality of life for all
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creative and leisure industries.



Department for Culture, Media and Sport 41

publications
level 2
A4 self-cover mission statement

Dimensions 
297/210mm
all measurements 
in millimetres

Mission statement
17/20pt Bliss Light

The mission statement must 
be typeset, with the correct
linebreaks, as shown

On self cover publications, where space is restricted, the
mission statement can appear on the back cover. It is
set at the base of the page, ranged right.

The mission statement appears in any of the DCMS
colours or white reversed out of a colour background.
Always ensure the copy is legible against the
background colour.
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publications
level 2
A4 contents

Dimensions 
297/210mm
all measurements 
in millimetres
example shown right-hand page

Main heading
28/30pt Bliss Light

rule below 0.5 pt width 
4mm offset, 50% black

Highlighted contents
information
11/18pt Bliss Bold

rule below 0.5 pt width 
1mm offset, 25% black

Page numbers
11pt Bliss Bold

Section heading
12/14pt Bliss Heavy, uppercase

additional 1mm space between
heading and body text

rule below 0.5 pt width 
1mm offset, 25% black

Contents information
11/16pt Bliss Light

Bullets 
indented by 4mm 
with 2mm space after

Page numbers
9pt Bliss Bold
3pt text inset on all edges
0.5pt keyline, 25% black
Box is 8mm/8mm

Running head
9/12pt Bliss Bold and
9/12pt Bliss Light 

Level 2 publication contents are designed to a set grid
structure and are printed in a single colour, black. (In
certain circumstances text pages can be two colour).

All the brand elements, positions and dimensions must be
consistently applied to achieve clear and effective
communications.

Main headings and introductory headings are set in upper
and lowercase, section headings should be set in
uppercase.
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Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh
euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad
minim veniam, quis nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip
commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in vulputate velit esse molestie consequat,
vel illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio dignissim
qui blandit praesent luptatum zzril delenit augue duis dolore te feugait nulla facilisi.
Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh
euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi amet,
consectetuer adipiscing elit, sed diam nonummy nibh euismod tincidunt ut laoreet enim
ad minim veniam, quis nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip
ex ea commodo consequat. Duis autem vel eum iriure dolor in hendrerit in vulputate
velit esse molestie consequat, vel illum dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit praesent luptatum zzril delenit augue duis
dolore te feugait nulla facilisi. Nam liber tempor cum soluta nobis eleifend option
congue nihil im perdiet doming id quod mazim placerat facer possim assum.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh
euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad
minim veniam, quis nostrud exerci tation ullamcorper suscipit aliquip ex ea commodo
consequat.

Duis autem vel eum iriure dolor in hendrerit in vulputate velit esse molestie consequat,
vel illum dolore eu feugiat nulla facilisis. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation
ullamcorper suscipit nihil imperdiet doming id quod mazim placerat facer possim assum.
Lorem ipsum lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum
iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel illum dolore eu
feugiat nulla facilisis at vero eros et accumsan et iusto odio dignissim qui blandit
praesent luptatum zzril delenit augue duis dolore te feugait nulla facilisi. Lorem ipsum
dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod tincidunt
ut laoreet dolore magna aliquam erat volutpa.

Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo consequat. Duis autem vel eum iriure dolor in hendrerit in
amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod tincidunt ut laoreet
vulputate velit esse molestie consequat, vel illum dolore eu feugiat nulla facilisis at vero
eros et accumsan et iusto odio dignissim qui blandit praesent luptatum zzril delenit
augue duis dolore te feugait nulla facilisi. Nam liber tempor cum soluta nobis eleifend
option congue nihil imperdiet doming id quod mazim placerat facer possim assum.
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LEVEL TWO HEADING

Lorem ipsum dolor sit amet, consectetuer adipiscing
elit, sed diam nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat volutpat. Ut wisi
enim ad minim veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit praesent
luptatum zzril delenit augue duis dolore te feugait
nulla facilisi. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat
volutpat. Ut wisi enim ad minim veniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequat. Duis autem vel
eum iriure dolor in hendrerit in vulputate velit esse
molestie consequat, vel illum dolore eu feugiat nulla
facilisis at vero eros et accumsan et iusto odio
dignissim qui blandit praesent luptatum zzril delenit
augue duis dolore te feugait nulla facilisi.
Nam liber tempor cum soluta nobis eleifend option
congue nihil imperdiet doming id quod mazim placerat
facer possim assum.

Level three heading

Lorem ipsum dolor sit amet, consectetuer adipiscing
elit, sed diam nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat volutpat. Ut wisi
enim ad minim veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut laoreet dolore magna

aliquam erat volutpat. Ut wisi enim ad minim veniam,
quis nostrud exerci tation ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo consequat. Duis autem
vel eum iriure dolor in hendrerit in vulputate velit esse
molestie consequat, vel illum dolore eu feugiat nulla
facilisis at vero eros et accumsan et iusto odio
dignissim qui blandit praesent luptatum zzril delenit
augue duis dolore te feugait nulla facilisi. Lorem ipsum
dolor sit amet, consectetuer adipiscing elit, sed diam
nonummy nibh euismod tincidunt ut laoreet dolore
magna aliquam erat volutpa.

Level three heading

Ut wisi enim ad minim veniam, quis nostrud exerci
tation ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat. Duis autem vel eum iriure dolor
in hendrerit in vulputate velit esse molestie consequat,
vel illum dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit praesent
luptatum zzril delenit augue duis dolore te feugait
nulla facilisi. Nam liber tempor cum soluta nobis
eleifend option congue nihil imperdiet doming id quod
mazim placerat facer possim assum. Lorem ipsum
dolor sit amet, consectetuer adipiscing elit, sed diam
nonummy nibh euismod tincidunt ut laoreet dolore
magna aliquam erat volutpat. Ut wisi enim ad minim
veniam, quis nostrud exerci tation ullamcorper suscipit
lobortis nisl ut aliquip ex ea commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim veniam,
quis nostrud exerci tation ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo consequat:
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1 Notes section, Title reference, p. 22

Level three heading

Lorem ipsum dolor sit amet, consectetuer adipiscing
elit, sed diam nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat volutpat. Ut wisi
enim ad minim veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim veniam,
quis nostrud exerci tation ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo consequat. Duis autem
vel eum iriure dolor in hendrerit in vulputate velit esse
molestie consequat, vel illum dolore eu feugiat nulla
facilisis at vero eros et accumsan et iusto odio
dignissim qui blandit praesent luptatum zzril delenit
augue duis dolore te feugait nulla facilisi. Lorem ipsum
dolor sit amet, consectetuer adipiscing elit, sed diam
nonummy nibh euismod tincidunt ut laoreet dolore
magna aliquam erat volutpat.

LEVEL TWO HEADING

Ut wisi enim ad minim veniam, quis nostrud exerci
tation ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat. Duis autem vel eum iriure dolor
in hendrerit in vulputate velit esse molestie consequat,
vel illum dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit praesent
luptatum zzril delenit augue duis dolore te feugait nulla
facilisi. Nam liber tempor cum soluta nobis eleifend
option congue nihil imperdiet doming id quod mazim
placerat facer possim assum. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim veniam,
quis nostrud exerci tation ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum dol
ore eu feugiat nulla facilisis. Duis autem vel eum iriure
dolor in hendrerit in vulputate velit esse molestie
consequat, vel illum dolore eu feugiat nulla facilisis at
vero eros et accumsan et iusto odio dignissim qui
blandit praesent luptatum zzril delenit augue duis
dolore te feugait nulla facilisi.

Pull out section

Lorem ipsum dolor sit amet, consectetuer adipiscing
elit, sed diam nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat volutpat.Ut wisi
enim ad minim veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat. Duis autem vel eum iriure dolor
in hendrerit in vulputate velit esse molestie
consequat, vel illum dolore eu feugiat nulla facilisis at
vero eros et accumsan et iusto odio dignissim qui
blandit praesent luptatum zzril delenit augue duis
dolore te feugait nulla facilisi. Nam liber tempor cum
soluta nobis eleifend option congue nihil imperdiet
doming id quod mazim placerat facer possim assum.
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Lorem ipsum dolor sit amet, consectetuer adipiscing
elit, sed diam nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat volutpat. Ut wisi
enim ad minim veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat.

Table one heading

Arts and culture 10%

Education and research 40%

Health 10%

Social services 18%

Environment 5%

Housing/development 4%

Advocacy 1%

International 0%

Religion 9%

Other 3%

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit praesent
luptatum zzril delenit augue duis dolore te feugait
nulla facilisi. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat
volutpat. Ut wisi enim ad minim veniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea modo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit praesent
luptatum zzril delenit augue duis dolore te feugait
nulla facilisi. Nam liber tempor cum soluta nobis
eleifend option congue nihil imperdiet doming id quod
mazim placerat facer possim assum. Ut wisi enim ad
minim veniam, quis nostrud exerci tation ullamcorper

suscipit lobortis nisl ut aliquip ex ea commodo
consequat. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat
volutpat. Ut wisi enim ad minim veniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim veniam,
quis nostrud exerci tation ullamcorper suscipit lobortis
nisl ut aliquip ex ea commodo consequat. Duis autem
vel eum iriure dolor in hendrerit in vulputate velit esse
molestie consequat, vel illum dolore eu feugiat nulla
facilisis at vero eros et accumsan et iusto odio
dignissim qui blandit praesent luptatum zzril delenit
augue duis dolore te feugait nulla facilisi. Lorem ipsum
dolor sit amet, consectetuer adipiscing elit, sed diam
nonummy nibh euismod tincidunt ut laoreet dolore
magna aliquam erat volutpa.

Table two heading

Arts and culture

Education and research

Health

Social services

Environment

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut laoreet dolore aliquam
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2.10 Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh
euismod tincidunt ut laoreet dolore magna
aliquam erat volutpat. Ut wisi enim ad minim
veniam, quis nostrud exerci tation ullamcorper
suscipit lobortis nisl ut aliquip ex ea commodo
consequa. Duis eu feugiat nulla facilisis at vero
eros et accumsan et iusto odio dignissim qui
blandit praesent luptatum zzril nostrud exerci
tation ullamcorper suscipit lobortis  delenit
augue duis dolore te feugait nulla facilisi. Lorem
ipsum dolor sit amet, consectetuer adipiscing
elit, sed diam nonummy nibh euismod tincidunt
ut laoreet dolore magna aliquam erat volutpat.
Ut wisi enim ad minim veniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea modo blandit praesent consequat.

Key one Key two

2.11 Ut wisi enim ad minim veniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequa. Duis eu
feugiat nulla facilisis at vero eros et accumsan et
iusto odio dignissim qui blandit praesent
luptatum zzril nostrud exerci tation ullamcorper
suscipit lobortis  delenit augue duis dolore te
feugait nulla facilisi. Lorem ipsum dolor sit amet,
cons ectetuer adipiscing elit, sed diam nonummy
nibh euismod tincidunt ut wisi enim ad minim
veniam, quis nostrud exerci tation ullamcorper.
Praesent luptatum zzril delenit augue duis dolore
te feug ait nulla facilisi.

Nam liber tempor cum soluta nobis eleifend
option congue nihil imperdiet doming id quod
mazim placerat facer possim assum. Ut wisi
enim ad minim veniam, quis nostrud exerci
tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequat.

Bar chart heading

Source of bar chart
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INDICATORS

Number beaches with a Blue Flag Award 9

Transport used on holiday trips by UK residents 10
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publications
Word documents
A4 contents

Dimensions 
297/210mm
all measurements 
in millimetres

Main heading
28/30pt Arial

rule below 0.5 pt width 
4mm offset, 50% black

Highlighted contents
information
11/18pt Arial Bold

rule below 0.5 pt width 
1mm offset, 25% black

Page numbers
11pt Arial Bold

Section heading
12/14pt  Arial, uppercase

additional 1mm space between
heading and body text

rule below 0.5 pt width 
1mm offset, 25% black

Contents information
11/16pt Arial

Page numbers
9pt Arial
0.5pt keyline, 25% black
Box is 8mm/8mm

Running head
9/11pt Arial (DCMS)
9/11pt Arial Bold (Document
title)

Publications produced in Microsoft Word are designed to
a set grid structure and are printed in single colour, black.

A template must be used and all information should be
consistent.

Arial is used instead of Bliss to ensure compatibility when
accessed by outside organisations.

23 14018 8 3 18

10
1

44

16

BACK TO CONTENTS>

20



08

The Government set out their strategy for developing and promoting a
sustainable approach to tourism in Tomorrow’s Tourism (DCMS 1999). This
promoted adopting of sustainable development principals based on Agenda 21
in all tourism strategies, whether at national, regional or local level together with
the need to develop a series of national statistical indicators to help measure
progress in achieving sustainable tourism.

The former English Tourist Council (ETC) published a sustainable strategy Time
for Action in 2001 in response to the challenges set down in Tomorrows Tourism
and the first set of indicators National Sustainable Tourism Indicators.

• Protect and enhance the natural environment and destinations;

• Support local communities and culture;

• Benefit the local economies of destinations.

Responsibility for developing the ETC’s sustainable tourism indicators passed to
DCMS in 2003 with the expectation of a further reporting cycle.

Level two heading
It has become increasingly evident to us as we have been collecting data for
these indicators that some are already being superseded by more sophisticated
thinking, especially at regional level, that data no longer exists, or the basis of
measurement has changed so that comparison of the data over time is not
possible. We therefore need to look again at the indicators developed by the
ETC to ensure that they remain relevant, that presentation of the data continues
to provide a true snapshot of sustainable tourism in England, and if new
indicators need to be developed to reflect current sustainable tourism priorities
and concerns.

Level three heading

The work programme outlined by the Tourism Reform Implementation Group
(TRIG) which was set up in 2004 to oversee the programme of work set out in
Tomorrow’s Tourism Today (DCMS 2004), will give us the opportunity to revise
the indicators. One of the key findings of the TRIG sub-group on sustainability
was that sustainability work should be at the centre of tourism strategy at all
levels and that it should be informed at operation level by an improved and web-
based Destination Managers Handbook which will provide all the tools
managers need for implementing a sustainable approach to tourism.

Main heading

Department for Culture, Media and Sport  
Document title National Sustainable Tourism Indicators

1 Notes section, Title reference, p.22
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publications
Word documents
text spread

Dimensions 
297/210mm
all measurements 
in millimetres and points
example shown left-hand page

Main heading
28/30pt Arial

rule below 0.5 pt width 
4mm offset, 50% black

Level two heading
21pt paragraph space before
heading
14/16pt Arial Bold

additional 2mm space between
heading and body copy

Level three heading 
21pt paragraph space before
heading
11/14pt Arial Bold

additional 2mm space between
heading and body copy

Body copy
11/16pt Arial 

Bulleted copy
indented 4mm with 
2mm space after

Page numbers
9pt Arial
0.5pt keyline, 25% black
Box is 8mm/8mm

Running head
9/11pt Arial (DCMS)
9/11pt Arial Bold (Document
title)

Notes
8/10pt Arial

Rule (above notes)
0.5 pt width,
25% black

Publications produced in Microsoft Word are designed to
a set grid structure and are printed in single colour, black.

A template must be used and all information should be
consistent.

Arial is used instead of Bliss to ensure compatibility when
accessed by outside organisations.
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level 2
back cover

Department for Culture, Media and Sport 54BACK TO CONTENTS>

Dimensions 
297/210mm
all measurements 
in millimetres

Logo
15mm wide

Address 
11/13pt Arial

Web address
11/13pt Arial Bold

The DCMS back cover must always feature the logo,
address and website. They appear in a consistent size and
position on every publication format.

Publications produced in Microsoft Word are designed to
a set grid structure and are printed in single colour, black.

A template must be used and all information should be
consistent.

Arial is used instead of Bliss to ensure compatibility when
accessed by outside organisations.

2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk

10

53

18

15



images

Department for Culture, Media and Sport 55

Photography is a powerful and dynamic tool. It can
communicate the diversity, energy and personality of
what we do. A great photo, used well, can tell a story far
better than words.

Photography should convey emotions and atmosphere. It
should encapsulate ideas about growth, innovation,
creativity and achievement. Look beyond the
straightforward and typical to find a more inspirational
perspective. Consider detail or unusual angles to create
effective communication and engage the audience.

Images can be reproduced in full colour, duotone or black
and white.

Only use images that are relevant and add value. Ensure
the content does not offend or alienate. Avoid clichés,
racial and gender stereotyping. Images must be print
quality, 300dpi.

BACK TO CONTENTS>

Photography examples © Getty Images, Axiom Photographic Agency, Merlin Hendy, Britain on View, Third Avenue, Empics, Alamy
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1. Start with an accessible document.

The easiest way to create an accessible PDF document is
to start with an accessible text document. Make sure your
Word document is formatted correctly with headers,
image tags etc.

To create accessible PDF documents you must have a

full copy of Adobe Acrobat Professional version 6+.

2. Open the PDF document in Adobe Acrobat:

(a) make sure the document is tagged. Go to: Advanced >
Accessibility > Add tags to document (this may have
already been done in another application – if so, click OK).

(b) Complete the Metadata information. Go to: File >
Document Properties. Under the Descriptions tab. Enter
a title, author and complete other fields as necessary.
(The author should be DCMS rather than an individual if
the document is going outside DCMS). Under Advanced
tab. Set the language to English.

(c) Set the tab order. Click the pages tag. Select all pages
of the document. Right click and select Open Page
Properties. Under tab order select the option for ‘use
document structure’.

(d) Then do a full check for accessibility. Go to: Advanced
> Accessibility > Full Check. Select ‘Start Checking’. This
will show any accessibility problems with the document.
Look out for problems with language, eg abbreviations or
figures (images) without alt tags.

3. Accessibility fixes:

Add alt tags to images. Select View > Navigation Tabs >
Tags. Locate figure tags within the structure tree and
select Options > Properties. Then complete the
description in Alternate Text field.

It can be helpful to keep the Highlight Content function
switched on in Options, then you can see the image
highlighted in the document.

Then, run the Full Check again to ensure problems are
fixed. And Save your document.

4. Use bookmarks

If your document is quite long, eg over 8 pages consider
using bookmarks. With the bookmark tab open. Go to the
page you want to jump to. Select Options > New
bookmark. Name the bookmark. Continue inserting
useful bookmarks through the document and delete any
that aren’t useful. When you are finished select Options
> Wrap Long Bookmarks. Go to File > Document
Properties and select Initial View. Finally in the
Documents Options panel, under Show select
Bookmarks Panel and Page

5. Optimise for the web

Finally you can reduce the size of your document. There
are two ways to do this.

(1) File > Save As. Save the document with the same
name to overwrite the original with your changes. This is
the most efficient method.

(2) File > Reduce File Size. Choose the option for
‘Acrobat 5 or later’ This method delivers the highest
compression. If you use this method always save the file
as a different document to check that the quality has not
been unacceptably degraded. If it has return to your
original document and use the Save As method.

BACK TO CONTENTS>
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PowerPoint
title slide
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Day Month Year  Name – job title

PowerPoint heading
Sub-heading

improving 
the quality 

of life for all

A DCMS PowerPoint template has been produced and should be
used for all presentations. Detailed separate guidelines are also
available, these have been produced to help you plan your
presentation and produce consistently branded slides.

The template contains styles for title, text, chart and image pages.

Heading

• Sub-heading
Enhancing access to a fuller cultural and sporting life for
children and young people and giving them the opportunity
to develop their talents to the full and to engage in healthy
recreation

• Sub-heading
Increasing and widening the impact of culture and sport, to
enrich individual lives, strengthen communities and improve
the places where people live

Department for Culture, Media and Sport Improving the quality of life for all

Bar chart heading
Sub-heading

Department for Culture, Media and Sport Improving the quality of life for all

00

00

00

00

00

00

00

00

00

00

00 00 00 00 00 00 00 00 00 00

Text slide heading

Department for Culture, Media and Sport Improving the quality of life for all

Our aim is to improve the quality
of life for all through cultural 
and sporting activities, support
the pursuit of excellence, and
champion the tourism, creative
and leisure industries.

 



PowerPoint
title slide
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Day Month Year  Name – job title

PowerPoint heading
Sub-heading

improving 
the quality 

of life for all

Day Month Year  Name – job title

PowerPoint heading
Sub-heading

improving 
the quality 

of life for all Day Month Year  Name – job title

PowerPoint heading
Sub-heading

improving 
the quality 

of life for all

Day Month Year  Name – job title

PowerPoint heading
Sub-heading

improving 
the quality 

of life for all

Title slides use a solid dark background from the DCMS colour 
palette with a white logo. A white background with a colour 
logo is also available.

Recommended background colours:
Pantone 279  R87 G138 B214
Pantone 308  R0 G94 B125
Pantone 5125  R112 G64 B94

Text highlight colour and strapline box:
Pantone 130  R230 G176 B18 or
Pantone 165  R245 G102 B0

Heading
40-50pt Arial

Sub-heading (if applicable)
24pt Arial

Date/name/job title
18pt Arial Bold, white

Bliss can also be used for internal presentations. However,
Bliss and Arial must not be used together in a presentation.

Department for Culture, Media and Sport 59
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PowerPoint
text slide
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Text slides use a white background. The maximum amount 
of body text should not exceed 80 words. Bullet points are 
indented by 5mm.

Heading sub-heading and bullet point colour:
Pantone 279  R87 G138 B214

DCMS sign-off:
Pantone 279  R87 G138 B214

Strapline:
Pantone 165  R245 G102 B0

Heading
40pt Arial

Sub-heading (if applicable)
24pt Arial

Body copy
24pt Arial

DCMS sign-off and strapline
12pt Arial

Bliss can also be used for internal presentations. However,
Bliss and Arial must not be used together in a presentation.

Heading

• Sub-heading
Enhancing access to a fuller cultural and sporting life for
children and young people and giving them the opportunity
to develop their talents to the full and to engage in healthy
recreation

• Sub-heading
Increasing and widening the impact of culture and sport, to
enrich individual lives, strengthen communities and improve
the places where people live

Department for Culture, Media and Sport Improving the quality of life for all

Heading

Increasing and widening the impact of culture and sport, to
enrich individual lives, strengthen communities and improve
the places where people live. Duis autem vel eum iriure dolor
in hendrerit in vulputate velit esse molestie consequat, vel
illum dolore eu feugiat nulla facilisis at vero eros et accumsan
et iusto odio dig nissim qui blandit praesent luptatum zzril
delenit augue duis dolore.

Department for Culture, Media and Sport Improving the quality of life for all

Heading

Sub-heading
Body copy lorem ipsum dolor sit amet, consectetuer adipielit,
sed diam nonummy nibh euismod tincidunt ut laoreet dolore
magna aliquam erat volutpat. Ut wisi enim minim veniam, quis
nostrud exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in vulputate velit
esse molestie consequat, vel illum dolore eu feugiat nulla
facilisis at vero eros et accumsan et iusto odio dig nissim qui
blandit praesent luptatum zzril delenit augue duis dolore.

Department for Culture, Media and Sport Improving the quality of life for all

Heading

• Bullet point copy set in Bliss twenty four point

• Indents are five millimetres from the edge of the text box

• Electronic templates are available

• Bullet point copy set in Bliss twenty four point

• Style for bullet point copy

Department for Culture, Media and Sport Improving the quality of life for all
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PowerPoint
charts and tables
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Chart slides and tables can be used to deliver complex
information in a simplified manner.

Select the most appropriate chart or table for the information
you need to deliver. Inappropriate and complicated information
graphics can lead to confusion and misunderstanding.
Colours and tints from the DCMS colour palette can be used to
aid legibility and understanding. The recommended minimum
copy size for chart information is 11 point.

Heading and sub-heading colour:
Pantone 279  R87 G138 B214

Heading
40pt Arial 

Sub-heading 
30pt Arial 

Chart information
11-24pt Arial Regular/Bold

Bliss can also be used for internal presentations. However,
Bliss and Arial must not be used together in a presentation.

Table heading

Olympic Bid

Charter Review

SR04

Diana Fountain

Public Health White Paper

Department for Culture, Media and Sport Improving the quality of life for all

Bar chart heading
Sub-heading

Department for Culture, Media and Sport Improving the quality of life for all

00

00

00

00

00

00

00

00

00

00

00 00 00 00 00 00 00 00 00 00

Text slide heading

Department for Culture, Media and Sport Improving the quality of life for all

Arts and culture 10%

Education and research 40%

Health 10%

Social services 18%

Environment 5%

Housing/development 4%

Advocacy 1%

International 0%

Religion 9%

Other 3%

Chart heading
Sub-heading

Department for Culture, Media and Sport Improving the quality of life for all

00% Slice 01
00% Slice 02 
00% Slice 03
00% Slice 04
00% Slice 05
00% Slice 06
00% Slice 07
00% Slice 08
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PowerPoint
photography
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Photographs should appear in full colour. The style and content of
photographs should reflect the diverse work of the Department
and be vibrant, inspirational and engaging.

Only use images that are relevant and add value. Ensure image
content does not offend, patronise or alienate. Avoid clichés, racial
and gender stereotyping. Clip-art should be avoided.

Images can be used full bleed (full page), provided the copy is
legible. The examples below illustrate how text and images can 
work together.

Images can be sourced from the DCMS image library.
Alternative images must not be used without prior permission
from the provider.

Text slide heading

Department for Culture, Media and Sport Improving the quality of life for all

• Bullet point copy set in Bliss 

• Indents are five millimetres
from the edge of the text box

• Use the electronic template

• Bliss twenty four point

• Style for bullet point copy

Text slide heading

Department for Culture, Media and Sport Improving the quality of life for all

“Quotation about the amazing positive results that sport
funding has achieved and how it has risen from £118 million
in 2004-05 to over £155 million in 2007-08”

Text slide heading

Department for Culture, Media and Sport Improving the quality of life for all

Our aim is to improve the quality
of life for all through cultural 
and sporting activities, support
the pursuit of excellence, and
champion the tourism, creative
and leisure industries.

Text slide heading

Department for Culture, Media and Sport Improving the quality of life for all



Unit Name
2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk

Tel 0207 211 0000
Fax 0207 211 0000
name.surname@
culture.gsi.gov.uk

Name Surname Your ref  000000
Spencer du Bois Our ref  0000
52-54 Rosebery Avenue
London 14 July 2006
EC1R 4 RP

Dear Name 

This letter is set in Bliss Light 12 point copy with 15 point linefeed. All copy is upper and lowercase.
All DCMS letters are set in the typeface Bliss. No other font can be used. The DCMS letterhead is set
in Bliss Light 12 point copy with 15 point linefeed. Notional copy designed to represent the printed
page and not designed to be read. All letters are set in the typeface Bliss.

This is set in Bliss Light 12 point copy with 15 point linefeed. Notional copy designed to represent
the printed page and not designed to be read. All letters are set in the typeface Bliss. This letter
template is set in Bliss Light 12 point copy with 15 point linefeed. Notional copy designed to
represent the printed page and not designed to be read. All letters are set in the typeface Bliss.

All letters are set in the typeface Bliss, if this is unavailable then Arial can be used as an alternative.
No other font can be used. This is set in Bliss Light 12 point copy with 15 point linefeed. Notional
copy designed to represent the printed page and not designed to be read. All letters are set in the
typeface Bliss. This is set in Bliss Light 12 point copy with 15 point linefeed. Notional copy designed
to represent the printed page and not designed to be read. All letters are set in the typeface Bliss.

Name Surname
Job title or description

22

11

41

11

15 13 20

170

45

90

letterhead
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23 16

20 19

Dimensions 
297/210mm
all measurements 
in millimetres

Logo
20mm wide

Unit name
10/12pt Bliss Medium

Unit address
10/12pt Bliss Roman

Letter template
12/15pt Bliss Light

‘Restricted’ heading (optional)
12/15pt Bliss Bold

letter template width 170mm

Strapline box
23mm wide

All DCMS letterheads are consistently designed.

The logo and strapline box are pre-printed in a single
DCMS colour. All other information prints black.

A template must be used for the letter, address,
customised contact details and accreditation logos.
The letter is set in upper and lowercase, ranged left,
ragged right.
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2-4 Cockspur Street  London SW1Y 5DH  www.culture.gov.uk

Tel 0207 211     

Fax 0207 211     

Email

@culture.gov.uk

compliment slip
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2014

13

7

47

823

Dimensions 
99/210mm
all measurements 
in millimetres

Logo
20mm wide

Address
10pt Bliss Roman

Contact details
10/14pt Bliss Roman

Rule
0.25pt
20% tint
offset by 1mm

Strapline box
23mm wide

All DCMS compliment slips are consistently designed.

They are printed in a selection of DCMS colours. The
contact details can be customised.

improving 
the quality 

of life for all
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Name Surname
Job title

Divisional Name
2-4 Cockspur Street
London SW1Y 5DH

Direct +44 (0)20 7211 0000
Fax +44 (0)20 7211 0000
Mobile +44(0)1234 000 000
name.surname@culture.gsi.gov.uk
www.culture.gov.uk

business card
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12.58

7

5

4

Dimensions 
85/55mm
all measurements 
in millimetres

Logo
12.5mm wide

Name
11/13pt Bliss Roman prints colour

Job title
8/10pt Bliss Roman prints colour

10pt space between job title
and divisional name

Divisional name
8/9.5pt Bliss Roman prints colour

Address
8/9.5pt Bliss Light prints black

4pt space between address 
and contact details

Contact details
8/9.5pt Bliss Light prints black

Web address
8/9.5pt Bliss Roman prints colour

all contact information works
upwards from the baseline

Strapline box
22mm wide

All DCMS business cards are consistently designed.

All cards are printed in two colours on the front and a
single colour on the reverse. They are available in a
selection of DCMS colours.

22 5

5

colour options

card reverse
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of life for all
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the quality 

of life for all
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of life for all

improving 
the quality 

of life for all

improving 
the quality 

of life for all
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All DCMS fax templates are consistently designed.

A template must be used. The fax is set in upper and
lowercase, ranged left, ragged right.

BACK TO CONTENTS>

Promotions & Publicity
2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk

Tel 0207 211 6268  
Fax 0207 211 6270
name.surname@
culture.gsi.gov.uk

To Name Surname Date Day Month Year

Fax no 0207 000 0000 Ref 00000000

Company Company Name No of pages 00

From Name Surname (including this)

Fax title

This fax is set in Bliss Roman 12 point copy with 15 point linefeed. All copy is upper and
lowercase. All DCMS fax templates are set in the typeface Bliss. No other font can be used. The
DCMS fax is set in Bliss Roman 12 point copy with 15 point linefeed. Notional copy designed to
represent the printed page and not designed to be read. All letters are set in the typeface Bliss.

This is set in Bliss Roman 12 point copy with 15 point linefeed. Notional copy designed to
represent the printed page and not designed to be read. All fax templates are set in the typeface
Bliss. This fax template is set in Bliss Roman 12 point copy with 15 point linefeed. Notional copy
designed to represent the printed page and not designed to be read. All fax templates are set in
the typeface Bliss.

All fax templates are set in the typeface Bliss, if this is unavailable then Arial can be used as an
alternative. No other font can be used. This is set in Bliss Roman 12 point copy with 15 point
linefeed. Notional copy designed to represent the printed page and not designed to be read. All
fax templates are set in the typeface Bliss.

improving 
the quality 

of life for all

fax

22

14

56

2

11

15 13 20

170

20

75

23 16

44 46

Dimensions 
297/210mm
all measurements 
in millimetres

Logo
20mm wide

Divisional name
10/12pt Bliss Medium

Address
10/12pt Bliss Roman

‘fax’
44pt Bliss Bold
50% tint

Recipient headings 
10/18pt Bliss Bold

Recipient details
indented by 20mm
10/18pt Bliss Roman

Rule
170mm wide
0.5pt, 50% tint

Fax template
fax template width 170mm
12/15pt Bliss Roman

Fax title
12/15pt Bliss Bold

Strapline box
23mm wide



2-4 Cockspur Street
London SW1Y 5DH
www.culture.gov.uk

news release
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the quality 

of life for all

CODE/00
00 Month 2006

DCMS NEWS RELEASE TITLE

This news release is set in Bliss Light 12 point copy with 16 point linefeed. All copy is upper and
lowercase. All DCMS letters are set in the typeface Bliss. No other font can be used. The DCMS news
release is set in Bliss Light 12 point copy with 16 point linefeed. Notional copy designed to represent
the printed page and not designed to be read. All letters are set in the typeface Bliss.

All news releases are set in the typeface Bliss, if this is unavailable then Arial can be used as an
alternative. No other font can be used. This is set in Bliss Light 12 point copy with 16 point linefeed.
Notional copy designed to represent the printed page and not designed to be read. All news releases
are set in the typeface Bliss. This is set in Bliss Light 12 point copy with 16 point linefeed. Notional
copy designed to represent the printed page and not designed to be read. This is set in Bliss Light 12
point copy with 16 point linefeed. Notional copy designed to represent the printed page and not
designed to be read. All news releases are set in the typeface Bliss. This news release template is set
in Bliss Light 12 point copy with 16 point linefeed. Notional copy designed to represent the printed
page and not designed to be read. All DCMS news releases are set in the typeface Bliss.

This is set in Bliss Light 12 point copy with 16 point linefeed. Notional copy designed to represent
the printed page and not designed to be read. All news releases are set in the typeface Bliss. This
news release template is set in Bliss Light 12 point copy with 16 point linefeed. Notional copy
designed to represent the printed page and not designed to be read. All DCMS news releases are set
in the typeface Bliss.

Bliss Light 12 point copy with 16 point linefeed. Notional copy designed to represent the printed
page and not designed to be read. This is set in Bliss Light 12 point copy with 16 point linefeed.

Press enquiries 020 7211 0000
Contact details 020 7211 0000
Public enquiries 020 7211 0000
www.culture.gov.uk

news release
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All DCMS news release templates are consistently
designed.

A template must be used. The news release is set in upper
and lowercase, ranged left, ragged right.

BACK TO CONTENTS>

22

14

55

11

172

20

23 16

44

Dimensions 
297/210mm
all measurements 
in millimetres

Logo
20mm wide

Address
10/12pt Bliss Roman

Website
10/12pt Bliss Medium

‘news release’
44pt Bliss Roman

Rule
offset by 2mm
172mm wide
0.5pt

News release template
Code
12/16pt Bliss Roman

Month
12/16pt Bliss Bold

Title
16/18pt Bliss Bold
uppercase

News release
12/16pt Bliss Roman

Contact details
12/16pt Bliss Bold

Strapline box
23mm wide
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website
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The website is a vital tool for communicating with the
Department’s stakeholders and audiences. It is the 
24-hour window in to DCMS and primary vehicle for
promoting the work that we do.

Our homepage divides into broad communication themes
to enable immediate access to our key initiatives and
successes. These themed areas facilitate greater
understanding about what DCMS does, and how and where
we add value by “improving the quality of life for all”.

The website utilises the core elements of the DCMS
brand. The colours are used throughout the site to create
interest. The homepage design echoes the Department’s
logo with its creative use of squares for the broad
communication areas. The site also reflects the look and
feel achieved by DCMS offline publications using strong
and vibrant images to convey a sense of dynamism
without making the site heavy on the eye.

All DCMS campaign websites or micro-sites should look
as if they belong to the same ‘family’, echoing the look
and feel of the DCMS site, using the DCMS logo
positioned left in conjunction with the DCMS colour
palette throughout.

Websites should reflect only the DCMS brand and not
have/become a brand in their own right unless express
permission has been received from the e-communications
manager.

Where co-branding is necessary the logo exclusion zone
must be observed or a separate page for partners
provided. The minimum size for the logo is 98 x 126
pixels. It should be always be surrounded by an area of
clear space.

Bliss or Clarendon can be used selectively as a design
feature but Arial is the Department’s default web
typeface. The type should be no less than 11pt for 
body copy.

Websites should be built to e-Government and W3C AA
accessibility guideline standards.
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Name Surname, Job Title for Culture, Media and 
Sport and Ministerial Title Name Surname invite

to drinks at The Venue Name
Venue Address, Location, London SW1Y 5DH
on Day Month Year from 0.00pm to 0.00pm

Venue directions or further information

2-4 Cockspur Street 
London SW1Y5DH 
RSVP on 020 7211 6215 
name.surname@culture.gsi.gov.uk

improving 
the quality 

of life for all

Dimensions 
148/210mm
all measurements 
in millimetres

Logo
17mm wide

Main copy
20/25pt Bliss Light

Rule (optional)
0.25pt
20mm space before rule
8mm space after rule

Venue information
14/18pt Bliss Regular, 70% tint

Venue directions/further
information (optional)
11/13pt Bliss Light

Address block
11/13pt Bliss Light

RSVP and contact details
11/13pt Bliss Medium

Strapline box
19mm wide

Invitations are designed to a set grid structure and are
printed in two colour, black and a colour from the DCMS
palette.

All the brand elements, positions and dimensions must be
consistently applied to achieve clear and effective
communications.

For certain launch events when a higher level of design
impact is required, appropriate photography, background
colour and illustration can be used.
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Name Surname, Job Title for Culture, Media and 
Sport and Ministerial Title Name Surname invite

to drinks at The Venue Name
Venue Address, Location, London SW1Y 5DH
on Day Month Year from 0.00pm to 0.00pm

Venue directions or further information

2-4 Cockspur Street 
London SW1Y5DH 
RSVP on 020 7211 6215 
name.surname@culture.gsi.gov.uk

improving 
the quality 

of life for all

Dimensions 
105/148mm
all measurements 
in millimetres

Logo
12.5mm wide

Main copy
14/18pt Bliss Light

Rule (optional)
0.25pt
14mm space before rule
6mm space after rule

Venue information
11/13pt Bliss Regular, 70% tint

Venue directions/further
information (optional)
9/11pt Bliss Light

Address block
9/11pt Bliss Light

RSVP and contact details
9/11pt Bliss Medium

Strapline box
13.5mm wide

Invitations are designed to a set grid structure and are
printed in two colour, black and a colour from the DCMS
palette.

All the brand elements, positions and dimensions must be
consistently applied to achieve clear and effective
communications.

For certain launch events when a higher level of design
impact is required, appropriate photography, background
colour and illustration can be used.
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Vice Chairman and two Governors
Ut wisi enim ad minim veniam – £00,000

Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat
volutpat. Ut wisi enim ad blandit praesent
nostrud exerci tation ullamcorper suscipit lobortis
nisl commodo consequat.
REF.000000/AA

Director of Marketing
Communications
Nam liber tempor cum soluta – £00,000

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero liber
tempor cum soluta nobis eleifend option congue
nihil imperdiet doming id quod mazim placerat
facer possim assum eros et accumsan et iusto
odio dignissim qui blandit praesent luptatum zzril
delenit augue duis dolore te feugait nulla facilisi.
Ref.000000/AA

Press Liaison
Lorum ipsum dolor – £00,000

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim vulputate velit
esse molestie consequat, vel illum qui blandit
praesent luptatum zzril delenit augue duis dolore
te feugait nulla facilisi. Lorem ipsum dolor sit
amet, consectetuer incidunt ut laoreet dolore
erat volutpat.
REF.000000/AA

IT Manager
Nam liber tempor cum soluta – £00,000

Ut wisi enim ad minim veniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequat. Nam liber
tempor cum soluta nobis eleifend option congue
nihil imperdiet doming id quod mazim placerat
facer assum.
REF.000000/AA

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim qui blandit
praesent luptatum zzril delenit augue duis dolore
te feugait nulla facilisi. Nam liber tempor cum
soluta nobis eleifend option congue nihil
imperdiet doming id quod mazim placerat facer
possim assum. Lorem ipsum dolor sit amet,
consectetuer adipiscin nonummy nibh consequat.
REF.000000/AA

Event Production Manager
Ut wisi enim ad minim veniam – £00,000

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat null orem ipsum dolor sit amet,
consectetuer adipiscing elit. Ullamcorper suscipit
lobortis nisl ut aliquip ex commodo consequat.
REF.000000/AA

For further details and an application form, contact duis
autem vel eum iriure dolor in hendrerit in vulputate velit
esse molestie consequat, vel illum dolore eu feugiat nulla
facilisis at vero eros et accumsan et iusto odio duis dolore
te feugait nulla facilisi.

New opportunities

Dimensions 
based on 200/153mm
all measurements 
in millimetres

Logo
14mm wide

Main heading
28/30pt Bliss Light, right aligned

Job title
11/13pt Bliss Bold

Sub title
10/12pt Bliss Light

additional 1mm space between
heading and body text

Body text
9/11pt Bliss Light

Reference number
7/11pt Bliss Bold, Uppercase

Further information
7/9pt Bliss Bold
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recruitment adverts
two column
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Recruitment adverts are designed to a set grid structure
and are printed in a single colour. Since the requirements
of individual advertisements differ it is not practical to
establish detailed specifications. However, the examples
on this and following page show the basic design
principles, alignment and type specifications.

All the brand elements, positions and dimensions must be
consistently applied to achieve clear and effective
communications.

Attention to detail must be observed when typesetting
adverts in order to produce well-balanced pages. It is also
the editor’s role to ensure the copy is written to fit.

Copy is set in upper and lowercase, ranged left and 
ragged right.



Vice Chairman and two Governors
Ut wisi enim ad minim veniam – £00,000
Lorum ipsum dolor – £00,000

Lorem ipsum dolor sit amet, consectetuer
adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat
volutpat. Ut wisi enim ad blandit praesent
nostrud exerci tation ullamcorper suscipit lobortis
nisl commodo consequat.

Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero liber
tempor cum soluta nobis eleifend option congue
nihil imperdiet doming id quod mazim placerat
facer possim assum eros et accumsan et iusto
odio dignissim qui blandit praesent luptatum zzril
delenit augue duis dolore te feugait nulla facilisi.
Duis autem vel eum iriure dolor in hendrerit in
vulputate velit esse molestie consequat, vel illum
dolore eu feugiat nulla facilisis at vero eros et
accumsan et iusto odio dignissim vulputate velit
esse molestie consequat, vel illum qui blandit
praesent luptatum zzril delenit augue duis dolore
te feugait nulla facilisi.

Lorem ipsum dolor sit amet, consectetuer
incidunt ut laoreet dolore erat volutpat. Ut wisi
enim ad minim veniam, quis nostrud exerci tation
ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat. Nam liber tempor cum
soluta nobis eleifend option congue nihil
imperdiet doming id quod mazim facer assum.
REF.000000/AA

New opportunities
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Dimensions 
based on 200/84mm
all measurements 
in millimetres

Logo
14mm wide

Main heading
15/17pt Bliss Light, right aligned

Job title
11/13pt Bliss Bold

Sub title
10/12pt Bliss Light

additional 1mm space between
heading and body text

Body text
9/11pt Bliss Light

Reference number
7/11pt Bliss Bold, Uppercase

Further information
7/9pt Bliss Bold
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Recruitment adverts are designed to a set grid structure
and are printed in a single colour. Since the requirements
of individual advertisements differ it is not practical to
establish detailed specifications. However, the examples
on this and following page show the basic design
principles, alignment and type specifications.

All the brand elements, positions and dimensions must be
consistently applied to achieve clear and effective
communications.

Attention to detail must be observed when typesetting
adverts in order to produce well-balanced pages. It is also
the editor’s role to ensure the copy is written to fit.

Copy is set in upper and lowercase, ranged left and 
ragged right.
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exhibitions

The DCMS brand must be consistently applied to all
exhibition and conference items.

The logo should always appear in the top left-hand corner
of the application (wherever possible) and reproduced
from a master reference. Bliss is the primary font,
Clarendon is the supporting font. The DCMS colour
palette must be used.

The strapline box should also appear and must be
reproduced from a master reference. It is designed to
interact with the individual design of each application
and create a visual balance with the logo.

It is important that the DCMS colours are matched
accurately on all materials, finishes and surfaces,
irrespective of the manufacturing process or printing
technique. It must always be ensured that the printer
achieves an accurate colour match.

BACK TO CONTENTS>
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Certain events, launches and conferences will require the
DCMS brand to appear on promotional items. From
clothing to conference name badges, promotional
merchandise to signage.

These are all high profile and important applications and
the elements of the DCMS brand should be consistently
applied.

The logo should always appear in the top left-hand corner
of the application (wherever possible) and reproduced
from a master reference. Bliss is the primary font,
Clarendon is the supporting font. The DCMS colour
palette must be used.

It is important that the DCMS colours are matched
accurately on all materials, finishes and surfaces,
irrespective of the manufacturing process or printing
technique. It must always be ensured that the printer
achieves an accurate colour match.

Materials and items that complement rather than conflict
with the brand should be considered when sourcing
promotional items. Contemporary, environmental,
ethically sourced, good quality materials are recommended.


